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Chapter 1. Troubleshooting

Troubleshooting, or problem determination, is the process of determining why a certain product is
malfunctioning.

Note: You can resolve some problems by ensuring that your system matches the system requirements
listed in the IBM Tivoli Monitoring IBM i OS Agent Installation and Configuration Guide.

See the following documents for general information about using the product:
v IBM Tivoli Monitoring Troubleshooting Guide

v IBM Tivoli Monitoring Administrator's Guide

v IBM Tivoli Monitoring User's Guide

Gathering product information for IBM Software Support
Before contacting IBM® Software Support about a problem you are experiencing with this product, gather
the following information that relates to the problem:

Table 1. Information to gather before contacting IBM Software Support

Information type Description

Log files
Collect trace log files from failing systems. See Chapter 2, “Configuring trace logging,” on
page 3 for lists of all trace log files and their locations. See the IBM Tivoli Monitoring
User's Guide for general information about the IBM Tivoli Monitoring environment.

Operating system Operating system version number and patch level

Messages Messages and other information displayed on the screen

Version numbers for
IBM Tivoli Monitoring

Version number of the components of the IBM Tivoli Monitoring monitoring
environment.

Upload files for review to the following FTP site: ftp.emea.ibm.com. Log in as anonymous and place
your files in the directory that corresponds to the IBM Tivoli Monitoring component that you use.

Built-in troubleshooting features
The primary troubleshooting feature in the IBM Tivoli Monitoring: IBM i OS Agent is logging. Logging
refers to the text messages and trace data generated by the IBM Tivoli Monitoring: IBM i OS Agent.
Messages are sent to the agent's message queue and a file is used to store trace data.

Trace data captures transient information about the current operating environment when a component or
application fails to operate as designed. IBM Software Support personnel use the captured trace
information to determine the source of an error or unexpected condition. See Chapter 2, “Configuring
trace logging,” on page 3 for more information.

Problem classification
The following types of problems might occur with the IBM Tivoli Monitoring: IBM i OS Agent:
v Installation and configuration
v General usage and operation
v Display of monitoring data

© Copyright IBM Corp. 1994, 2013 1



v Take Action commands

Troubleshooting process
Use the following process to determine the source of problems in Monitoring Agent for IBM i OS:
1. View the message queue for the agent by entering the DSPOMALOG command on an IBM i OS

command line.
2. When you want further information about an item that you see in the message queue, view the trace

logs that are described in Chapter 2, “Configuring trace logging,” on page 3.
3. Some problems leave messages in the agent's job log. The agent's job log can be viewed by:

a. Enter the command WRKUSRJOB USER(QAUTOMON) on an IBM i OS command line to see the
list of active and completed agent jobs. The agent jobs have the name CT_AGENT.

b. If an agent's job in the list shows a status of ACTIVE then the job log can be viewed using option
5, Work with, then option 10, Display job log.

c. If an agent's job in the list shows a status of OUTQ then the job log can be viewed using option 5,
Work with, then option 4, Work with spooled files, then option 5, Display.

4. Some problems initiate dumps of information or print data areas for debugging purposes. These
dumps and print files are saved as spool files for the QAUTOMON user profile. They can be viewed
by entering the command 'WRKSPLF SELECT(QAUTOMON)' on an IBM i OS command line. The
names of the spool files help to indicate their contents. Some names you might see include:
v QPJOBLOG -- job log for a completed job
v QPRINT -- standard output from a job
v QPSRVDMP -- dump file (possibly from DMPOBJ, Dump Object command)
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Chapter 2. Configuring trace logging

Trace logs capture information about the operating environment when component software fails to
operate as intended. The principal log type is the RAS (Reliability, Availability, and Serviceability) trace
log. These logs are in the English language only. The RAS trace log mechanism is available for all
components of IBM Tivoli Monitoring.

Note: The documentation refers to the RAS facility in IBM Tivoli Monitoring as "RAS1".

The member KBBENV in file QAUTOTMP/KMSPARM stores the variables for trace logging in
Monitoring Agent for IBM i OS. By default, trace logs are stored in the QAUTOTMP library.

For more information on the complete set of trace logs that are maintained on the monitoring server, see
the IBM Tivoli Monitoring Installation and Setup Guide.

IBM Software Support uses the information captured by trace logging to trace a problem to its source or
to determine why an error occurred. The default configuration for trace logging, such as whether trace
logging is enabled or disabled and trace level, depends on the source of the trace logging. Trace logging
is always enabled.

To learn how to configure and use trace logging, seee the following sections:
v “Managing log files”
v “Targeting which modules to trace” on page 4
v “Using trace logs” on page 4

Managing log files
By default, trace log data goes to three files (KA4AGENT01, KA4AGENT02, and KA4AGENT03) that are
defined by the following configuration variable:
KBB_RAS1_LOG=(QAUTOTMP/KA4AGENT01 QAUTOTMP/KA4AGENT02 QAUTOTMP/KA4AGENT03 )\
INVENTORY=QAUTOTMP/KA4RAS.INV LIMIT=5 PRESERVE=1

The files are used as follows:
1. The files fill with trace log data in order:

a. The KA4AGENT01 file receives trace log data until it reaches the size of 5 MB, the default setting
defined by the LIMIT=5 parameter.

b. The KA4AGENT02 file receives trace log data until it reaches the size of 5 MB.
c. The KA4AGENT03 file receives trace log data until it reaches the size of 5 MB.

2. Trace logging continues in the second log file, KA4AGENT02. The PRESERVE=1 setting prevents the
overwriting of the first log file.

3. When you want to troubleshoot the monitoring agent, refer to the time stamp of the three trace log
files. The most recent file could be any of the three files, depending on when trace logging transferred
from one file to the other.

You can modify the KBB_RAS1_LOG variable to modify logging behavior. You must ensure that
QAUTOMON has sufficient authority to access the files if you use a library other than QAUTOTMP.
v PRESERVE parameter: You can configure logging to preserve the initial log file, which contains useful

startup information. The default is 1, which means that the first log file is never overwritten when logs
roll.

v LIMIT parameter: You can configure logging to have a different maximum size of files in MB (LIMIT).
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Note: Do not configure the LIMIT setting to be greater than 100 MB. On IBM i OS, when file size
reaches 100 MB, the process associated with the file is suspended, and the system sends notification to
the system administrator. Monitoring stops and the file size status must be resolved manually.

Targeting which modules to trace
The type of trace messages to log and which modules to log messages for are controlled by configuration
settings. By default the KBB_RAS1=ERROR configuration setting logs the trace statements for type
“Error” in all the modules.

The modules written specifically for the IBM i OS agent have names staring with 'ka4', and modules
common to agents have names starting with 'kra', 'kbb', 'kdc', and others. The following setting logs all
the trace statements for all the modules starting ka4 and kra.
KBB_RAS1=ERROR (UNIT:KA4 ALL) (UNIT:KRA ALL)

The ka4 and kra strings are wild cards in this statement. You can also enter the names of individual
modules in a UNIT statement.

For maximum efficiency (including during agent shutdown), when no agent function investigation is
needed, you could disable all tracing by setting KBB_RAS1=NONE.

Using trace logs
Typically IBM Software Support applies specialized knowledge to analyze trace logs to determine the
source of problems. However, you can view trace logs to learn some basic facts about your IBM Tivoli
Monitoring environment.
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Chapter 3. Problems and workarounds

The known problems and workarounds are organized into types of problems that might occur with an
agent, for example installation and configuration problems and workspace problems.

You can resolve some problems by ensuring that your system matches system requirements. The most
up-to-date requirements are in the Software product compatibility reports (http://
publib.boulder.ibm.com/infocenter/prodguid/v1r0/clarity/index.html).

For general troubleshooting information, see the IBM Tivoli Monitoring Troubleshooting Guide.

Agent troubleshooting
Table 2 provides agent-specific troubleshooting information. For general troubleshooting information, see
the IBM Tivoli Monitoring Troubleshooting Guide.

Table 2. Agent problems and solutions

Problem Solution

The IBM i OS monitoring agent fails
to install or uninstall on a Japanese
Katakana/Kanji system in some
codepage environments. The install
or uninstall program might not work
correctly on systems where the job
CCSID is 5026 or 290, which are
typical Japanese Katakana/Kanji
systems. Other languages (job
CCSIDs) that might be affected
include Simplified Chinese (935,
1388), Traditional Chinese (937), and
Korean (933).

Symptoms of the failed install or
uninstall include message id
CPF3D95, messages in the job log
that indicate “object not found”, or
an IFS directory that has incorrect
characters in the path name.

The CCSID of the job that runs the install or uninstall program determines
whether this problem occurs. CCSIDs where the lowercase a-z are not in the
same location as CCSID 37 cause the install or uninstall to fail.
Note: Having English installed or not installed as a secondary language does
not affect this problem.

To avoid this problem, change the job CCSID to 37 before running the install
or uninstall command. Perform the following steps to change the job CCSID
before running the install or uninstall commands. After the install or
uninstall commands are complete, restore the original job CCSID.

1. Note the current job CCSID and default CCSID using DSPJOB, option 2.
For example:

Coded character set identifier . . . . . : xxxx
Default coded character set identifier . : yyyy

2. Change the job CCSID.

CHGJOB CCSID(37)

3. Run the install or uninstall command.

4. Restore the orignal CCSID with the following commands. It is important
to change to the default job CCSID before changing to the original job
CCSID so that the IGC job attribute is properly reset.

CHGJOB CCSID(yyyy)
CHGJOB CCSID(xxxx)

© Copyright IBM Corp. 1994, 2013 5
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Table 2. Agent problems and solutions (continued)

Problem Solution

A configured and running instance of
the monitoring agent is not
displayed in the Tivoli Enterprise
Portal, but other instances of the
monitoring agent on the same system
do appear in the portal.

Tivoli® Monitoring products use Remote Procedure Call (RPC) to define and
control product behavior. RPC is the mechanism that allows a client process
to make a subroutine call (such as GetTimeOfDay or ShutdownServer) to a
server process somewhere in the network. Tivoli processes can be configured
to use TCP/UDP, TCP/IP, SNA, and SSL as the desired protocol (or delivery
mechanism) for RPCs.

“IP.PIPE” is the name given to Tivoli TCP/IP protocol for RPCs. The RPCs
are socket-based operations that use TCP/IP ports to form socket addresses.
IP.PIPE implements virtual sockets and multiplexes all virtual socket traffic
across a single physical TCP/IP port (visible from the netstat command).

A Tivoli process derives the physical port for IP.PIPE communications based
on the configured, well-known port for the HUB Tivoli Enterprise
Monitoring Server. (This well-known port or BASE_PORT is configured using
the 'PORT:' keyword on the KDC_FAMILIES / KDE_TRANSPORT
environment variable and defaults to '1918'.)

The physical port allocation method is defined as (BASE_PORT + 4096*N)
where N=0 for a Tivoli Enterprise Monitoring Server process and N={1, 2, ...,
15} for a non-Tivoli Enterprise Monitoring Server. Two architectural limits
result as a consequence of the physical port allocation method:

v No more than one Tivoli Enterprise Monitoring Server reporting to a
specific Tivoli Enterprise Monitoring Server HUB can be active on a
system image.

v No more that 15 IP.PIPE processes can be active on a single system image.

A single system image can support any number of Tivoli Enterprise
Monitoring Server processes (address spaces) provided that each Tivoli
Enterprise Monitoring Server on that image reports to a different HUB. By
definition, there is one Tivoli Enterprise Monitoring Server HUB per
monitoring Enterprise, so this architecture limit has been simplified to one
Tivoli Enterprise Monitoring Server per system image.

No more that 15 IP.PIPE processes or address spaces can be active on a
single system image. With the first limit expressed above, this second
limitation refers specifically to Tivoli Enterprise Monitoring Agent processes:
no more that 15 agents per system image.

This limitation can be circumvented (at current maintenance levels, IBM
Tivoli Monitoring V6.1 Fix Pack 4 and later) if the Tivoli Enterprise
Monitoring Agent process is configured to use EPHEMERAL IP.PIPE. (This is
IP.PIPE configured with the 'EPHEMERAL:Y' keyword in the
KDC_FAMILIES / KDE_TRANSPORT environment variable). There is no
limitation to the number of ephemeral IP.PIPE connections per system image.
However, EPHEMERAL endpoints are restricted: data warehousing cannot
be performed on an ephemeral endpoint.

The monitoring agent does not
connect to the monitoring server.
CT_CMS is enclosed within
parentheses like this:

CT_CMSLIST="IP.PIPE:(10.25.97.62);
IP:(10.25.97.62)

instead of being like this

CT_CMSLIST="IP.PIPE:#10.25.97.62;
IP:#10.25.97.62

Reconfigure the agent by specifying the monitoring server's TCP/IP address
as *NONE. Also specify the monitoring server's IP.PIPE address to the IP
address of the monitoring server. Leave the Firewall in use parameter set
to *YES. After reconfiguring and restarting the agent, the agent should
connect to the monitoring server correctly.
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Table 2. Agent problems and solutions (continued)

Problem Solution

The monitoring agent is not able to
start, and the log file states there is a
communication error.

Specify the monitoring server's IP address in the IP.PIPE setting.

CT_AGENT Job logs are not created. Job Logs are not produced if there are no exceptions encountered while the
agent running. However, if the job logs are needed there are 2 solutions that
force the agent to produce job logs.

v Change the Message Logging level on job QAUTOMON/QAUTOMON
from:

Level . . . . . . . . . . . . . . . . . . . . : 4
Severity . . . . . . . . . . . . . . . . . . . : 0
Text . . . . . . . . . . . . . . . . . . . . . : *NOLIST

to:

Level . . . . . . . . . . . . . . . . . . . . : 4
Severity . . . . . . . . . . . . . . . . . . . : 0
Text . . . . . . . . . . . . . . . . . . . . . : *SECLVL

v Delete the KA4RAS.INV file in the QAUTOTMP library before starting the
agent. The CT_AGENT job encounters an exception if this file does not
exist and logs a message in the job log.

There is a length inconsistency with
OS400_Message.Key.

The OS400_Message.Key length is 5 character values, and IBM i OS uses 4
character values. The first 2 bytes need to be ignored if the customized
program is used to reply to the messages. This monitoring agent provides
the RPYMSG CL program in the QAUTOMON library that can be used to
reply to messages from Take Actions. You can retrieve and use the source of
the CL program to customize it according to your needs. For more
information on the Take Action commands, see the IBM Tivoli Monitoring
IBM i OS Agent Reference.

When you edit the configuration for
an existing monitoring agent, the
values displayed are not correct.

The original configuration settings might include non-ASCII characters.
These values were stored incorrectly and result in the incorrect display. Enter
new values using only ASCII characters.

Attributes do not allow non-ASCII
input in the situation editor.

None. Any attribute that does not include “(Unicode)” might support only
ASCII characters. For example “Attribute (Unicode)” will support unicode
but “Attribute” without “(Unicode)” might only support ASCII characters.

Historical reporting fails. The location of short-term history files depends on the configuration variable
CTIRA_HIST_DIR in the QAUTOTMP/KMSPARM( KBBENV) file. The default
value is CTIRA_HIST_DIR=/QIBM/USERDATA/IBM/ITM/HIST.

If you change the CTIRA_HIST_DIR variable to another directory, you must do
the following to ensure success of historical data collection:

v Create the directory in Integrated File System (IFS).

v Give QAUTOMON read, write, and execute (*RWX) access to the new
directory.
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Table 2. Agent problems and solutions (continued)

Problem Solution

You see the following message when
you select Display Tivoli
Monitoring: IBM i Agent Log:
Function check. MCH2002
unmonitored by QNMDRGTI at
statement *N instruction X’0024

This problem occurs whenever the following situations stop:

v Any situation based on the APPN topology attributes

v All situations, when agents lose connection to the monitoring server (In
this case, all situations are automatically stopped.)

These messages are generated during the cleanup process for a stopped
situation. For example, in the case of APPN topology attributes, threads are
used in QNMDRGTI and must be cleaned up. These messages are harmless
and you can ignore them. To restore monitoring activity, restart the agent or
restore connectivity with the monitoring server, as appropriate.

The following excerpt shows related information from the joblog of the
CT_Agent job. You can also ignore this information:

Event monitor does not exist.
Dump output directed to spooled file 1, job 304099/QAUTOMON/CT_AGENT
created on system MINERVA on 09/05/05 13:08:35.
The requested information cannot be dumped.
Dump output directed to spooled file 3, job 304099/QAUTOMON/CT_AGENT
created on system MINERVA on 09/05/05 13:08:37.
Software problem data for QNMDRGTI has been detected.
Event monitor does not exist.
Function check. MCH2002 unmonitored by QNMTIXT at statement *N,
instruction X’001A’.

The user account used for reflex
automation commands is invalid.

QAUTOMON is the default user that is used to execute reflex automation or
Take Action commands. To change this assignment, set the Action user
profile in Configure Tivoli Monitoring: IBM i Agent to different value. The
valid values are QAUTOMON or a value that starts with an asterisk (*). If
you set a value starting with an asterisk, like *SIT, the user who created the
situation is used to run the reflex automation commands. To assign a user
other than QAUTOMON, create a user with that name on the Tivoli
Enterprise Portal. Log in using that user ID and create a situation with some
action to be executed on the monitoring agent. If that situation is started and
triggered, the action configured in that situation is executed under the user
who created the situation.

High CPU utilization by the
CT_AGENT job.

Check for the following problems:

1. Some situations may be causing the monitoring agent to drive more data
collection. To identify such situations,

a. Stop all the custom situations and uncheck “Run at startup”.

b. Start the monitoring agent with only product provided situations and
verify the CPU utilization.

c. If the CPU utilization is normal , start one situation at a time and
verify the process.

2. Historical data collection may be causing the agent to have high CPU
use.

a. Confirm the historical data being collected is required. There is no
need to collect all the data that is available, unless it is being used.

b. Consider increasing the time between historical data collections. For
items such as installed software a daily, weekly or even monthly
interval might prove sufficient.

Continue this process for all the situations until you identify the situation
that is causing the CT_AGENT job to consume high CPU. Correct the
situations by changing the formula or increasing the interval to consume
fewer CPU cycles.

8 IBM Tivoli Monitoring: IBM i OS Agent Troubleshooting Guide



Table 2. Agent problems and solutions (continued)

Problem Solution

DASD fill with *MGTCOL objects
and objects in QMPGDATA library.

This can be reduced to some extent by not collecting the data as frequently
as set for various types of resources other than defaults using the
configuration variables in QAUTOTMP/KMSPARM(KBBENV).

KA4_JOB_DATA_INTERVAL=15
KA4_IOP_DATA_INTERVAL=30
KA4_DISK_DATA_INTERVAL=30
KA4_POOL_DATA_INTERVAL=15
KA4_COMM_DATA_INTERVAL=60

Monitoring Agent for IBM i OS
crashes with more jobs on the system
or the data not displayed on Tivoli
Enterprise Portal quickly.

Systems running with large number of jobs is the major cause of failures or
the poor response. The following configuration variables in
QAUTOTMP/KMSPARM(KBBENV) can be used to reduce the number of
jobs being monitored:

v KA4_JOB_COUNT=20480 By default, it allocates space for 20480 jobs, can
be increased to higher value on systems with more jobs.

v KA4_LJOB_NAME=*ALL JOB NAME FILTER , Any name with maximum
of 10 chars.

v KA4_LJOB_USER=QUSER JOB USER FILTER , Any name with maximum
of 10 chars.

v KA4_LJOB_NBR=*ALL JOB NUMBER FILTER , Any 6 digit number.

v KA4_LJOB_TYPE=* JOB TYPE 1 char valid values * A B I M R S W X

* This value lists all job types.
A The job is an autostart job.
B The job is a batch job.
I The job is an interactive job.
M The job is a subsystem monitor job.
R The job is a spooled reader job.
S The job is a system job.
W The job is a spooled writer job.
X The job is the start-control-program-function

(SCPF) system job.

v KA4_LJOB_STS=*ACTIVE JOB TYPE 10 char Valid Values *ACTIVE
*JOBQ *OUTQ *ALL

You receive a message saying that
the CPF3CAA-List is too large for a
user space. This indicates that the
query or situation needs to be
filtered using both the change to the
library list as well as a change in the
QAUTOTMP/KMSPARM file.

Change the QAUTOMON job description in the *USRLIBL portion of the
CT_AGENT job, adding any libraries that contain files you want to monitor.
Change KA4_OBJFLT_LIB=*ALL to KA4_OBJFLT_LIB=*USRLIBL in the
QAUTOTMP/KMSPARM file, and then restart the agent. You should then be able to
use the situation to compare the changed date/time to the localtimestamp.

This change limits the amount of objects that are retrieved to the *USRLIBL
portion of the CT_AGENT job library list, which also limits the CPU and I/O
when using the IBM i OS system API to only those that are found in the
*USRLIBL portion of the library list.

Unique names for monitoring components
If you have multiple instances of a monitoring agent, you must decide how to name the monitoring
agents. This name is intended to uniquely identify that monitoring agent. The agent's default name is
composed of three qualifiers:
v Optional instance name
v Machine network hostname
v Agent product node type

An agent name truncation problem can occur when the network domain name is included in the network
hostname portion of the agent name. For example, instead of just the hostname myhost1 being used, the
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resulting hostname might be myhost1.acme.north.prod.com. Inclusion of the network domain name
causes the agent name in the example above to expand to SERVER1:myhost1.acme.north.prod.com:KXX.
This resulting name is 39 characters long. It is truncated to 32 characters resulting in the name
SERVER1:myhost1.acme.north.prod.

The agent name truncation is only a problem if there is more than one monitoring agent on the same
system. In this case, the agent name truncation can result in collisions between agent products attempting
to register using the same truncated name value. When truncated agent names collide on the same
system, this can lead to Tivoli Enterprise Monitoring Server problems with corrupted EIB tables. The
agent name collision in the Tivoli Enterprise Monitoring Server might cause a registered name to be
associated with the wrong product.

In general, create names that are short but meaningful within your environment. Use the following
guidelines:
v Each name must be unique. One name cannot match another monitoring agent name exactly.
v Each name must begin with an alpha character.
v Do not use blanks or special characters, including $, #, and @.
v Each name must be between 2 and 32 characters in length.
v Monitoring agent naming is case-sensitive on all operating systems.

Create the names by completing the following steps:
1. Open the configuration file for the monitoring agent, which is located in the following path:

v On Windows: install_dir\tmaitm6\Kproduct_codeCMA.INI. For example, the product code for the
Monitoring Agent for Windows OS is NT file name for is KNTCMA.INI.

v On UNIX and Linux: install_dir/tmaitm6/product_code.ini and product_code.config. For
example, the file names for the Monitoring Agent for UNIX OS is ux.ini and ux.config.

2. Find the line the begins with CTIRA_HOSTNAME=.
3. Type a new name for host name that is a unique, shorter name for the host computer. The final

concatenated name including the subsystem name, new host name, and A4, cannot be longer than 32
characters.

Note: You must ensure that the resulting name is unique with respect to any existing monitoring
component that was previously registered with the Tivoli Enterprise Monitoring Server.

4. Save the file.
5. Restart the agent.
6. If you do not find the files mentioned in Step 1, perform the workarounds listed in the next

paragraph.

If you do not find the files mentioned in the preceding steps, perform the following workarounds:
1. Change CTIRA_HOSTNAME environment variable in the configuration file of the monitoring agent.

v Find the KA4ENV file in the same path mentioned in the preceding row.
v For z/OS® agents, find the RKANPAR library.
v For IBM i OS agents, find the QAUTOTMP/KMSPARM library in member KBBENV.

2. If you cannot find the CTIRA_HOSTNAME environment variable, you must add it to the
configuration file of the monitoring agent:
v On Windows: Use the Advanced > Edit Variables option.
v On UNIX and Linux: Add the variable to the config/product_code.ini and to config/

product_code.config files.
v On z/OS: Add the variable to the RKANPAR library, member Kproduct_codeENV.
v On IBM i OS: Add the variable to the QAUTOTMP/KMSPARM library in member KBBENV.
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3. Some monitoring agents (for example, the monitoring agent for MQ Series) do not reference the
CTIRA_HOSTNAME environment variable to generate component names. Check the documentation
for the monitoring agent that you are using for information on name generation. If necessary, contact
IBM Software Support.

Workspace troubleshooting
Table 3 describes problems that might occur with workspaces. For general troubleshooting information,
see the IBM Tivoli Monitoring Troubleshooting Guide.

Table 3. Workspace problems and solutions

Problem Solution

You see the following message: KFWITM083W
Default link is disabled for the selected
object; please verify link and link anchor
definitions.

You see this message because some links do not have default
workspaces. Right-click the link to access a list of workspaces to
select.

The name of the attribute does not display in a
bar chart or graph view.

When a chart or graph view that includes the attribute is scaled
to a small size, a blank space is displayed instead of a truncated
name. To see the name of the attribute, expand the view of the
chart until there is sufficient space to display all characters of the
attribute's name.

At the bottom of each view, you see the
following Historical workspace KFWITM220E
error: Request failed during execution.

Ensure that you configure all groups that supply data to the
view. In the Historical Configuration view, ensure that data
collection is started for all groups that supply data to the view.

You start collection of historical data but the data
cannot be seen.

Managing options for historical data collection:

v Basic historical data collection populates the Warehouse with
raw data. This type of data collection is turned off by default.
See the IBM Tivoli Monitoring IBM i OS Agent Installation and
Configuration Guide for information on managing this feature
including how to set the interval at which data is collected. By
setting a more frequent interval for data collection you reduce
the load on the system incurred every time data is uploaded.

v You use the Summarization and Pruning monitoring agent to
collect specific amounts and types of historical data. Be aware
that historical data is not displayed until the Summarization
and Pruning monitoring agent begins collecting the data. By
default, this agent begins collection at 2 AM daily. At that
point, data is visible in the workspace view. See the IBM Tivoli
Monitoring Administrator's Guide to learn how to modify the
default collection settings.
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Table 3. Workspace problems and solutions (continued)

Problem Solution

Messages and Spool workspace does not display
data.

The views based on the Message attribute group such as
Operator Message view and Managed Systems for i5/OS™ Logs
display the data based on the time span set for those views. By
default it displays messages for last 2 hours. To change this
behavior, click the Timespan icon on the left hand corner of the
view on Tivoli Enterprise Portal. The time zone between System
i® server and Tivoli Enterprise Portal Server also affects the data
collected on these views. Consider the following scenario:

v Monitoring Agent for IBM i OS runs on a System i server
which is operating in the Pacific time zone.

v The Tivoli Enterprise Portal Server runs in the Central time
zone.

In this scenario, the data might not be displayed in the Messages
views. Change the Timespan setting accordingly to enable the
Tivoli Enterprise Portal to show the data.
Note: If you assign a Timespan of the last 24 hours, you would
satisfy all time zones. However, this setting would increase the
overhead if both systems are in same time zone and are slightly
different.

Unable to view data for a default query in a
workspace

v A default query should display data when it is assigned to the
view on the workspace. However, if this is a view that has
links, such as the Licensed Program Products workspace, a
link must be selected in order to see the data in the
workspace.

v Some functions require granting the QAUTOMON user ID
additional privileges.

No data displayed for IOA Cache Battery v Install any missing PTFs.

v The system may not have IO adapters with batteries. To check
if the system has storage adapters with batteries, use the IBM i
OS function in Dedicated Service Tools --STRDST.
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Situation troubleshooting
Table 4 lists problems that might occur with specific situations.

Table 4. Specific situation problems and solutions

Problem Solution

A situation formula that uses an
enumerated value beginning with an *
triggers on unexpected values. For
example, a situation monitoring
subsystems with a formula that checks
for *ACTIVE also triggers for
subsystems that are *INACTIVE.

The IBM i OS uses a leading * to signify special values. IBM Tivoli
Monitoring uses a leading * to indicate a wildcard character in situation
formulas. Using a leading * might result in some enumerated values
where one special value is a substring of another special value. For
example, a situation formula that specifies KA4SBS.STATUS == *ACTIVE will
trigger for subsystems that are both *ACTIVE and *INACTIVE. The * is
considered a wildcard in the formula and "== *ACTIVE" matches both
*ACTIVE and *INACTIVE. Other common examples of special values
with these characteristics include:
*NORMAL and *ABNORMAL

(i5/OS Inactive Job - Completion Status)
*PGM and *SRVPGM

(OS400 Object - Type)

To resolve this problem, change the formula to use the != operator and
use the longer special value. In the above example, change the formula to
specify KA4SBS.STATUS != *INACTIVE. This formula is equivalent to
KA4SBS.STATUS == *ACTIVE and prevents the * wildcard from matching
both special values.
Note: This scenario applies to situations only, not queries.

You want to change the appearance of
situations when they are displayed in a
Workspace view.

1. Right-click an item in the Navigation tree.

2. Select Situations in the pop-up menu. The Situation Editor window is
displayed.

3. Select the situation that you want to modify.

4. Use the Status pull-down menu in the lower right of the window to
set the status and appearance of the Situation when it triggers.
Note: This status setting is not related to severity settings in IBM
Tivoli Enterprise Console.

You see multiple situation starting and
stopping messages in the KMSOMLOG
(MSG2) file.

Multiple situation starting and stopping messages can appear in the agent
message console for the following reasons:

v The Take Action is defined with either a System Command or a
Universal Message in the Action tab of the Situation Editor.

v An embedded situation resides in different attribute groups.

Provide situation formulas for the situations with duplicate entries.

Situations are triggered in the Tivoli
Enterprise Monitoring Server, but events
for the situation are not sent to the
Tivoli Enterprise Console® server. The
Tivoli Enterprise Monitoring Server is
properly configured for event
forwarding, and events for many other
situations are sent to the event server.

This condition can occur when a situation is only monitoring the status of
other situations. The event forwarding function requires an attribute
group reference in the situation in order to determine the correct event
class to use in the event. When the situation only monitors other
situations, no attribute groups are defined and the event class cannot be
determined. Because the event class cannot be determined, no event is
sent.

This is a limitation of the Tivoli Enterprise Monitoring Server event
forwarding function. Situations that only monitor other situations do not
send events to the event server.

Monitoring activity requires too much
disk space.

Check the RAS trace logging settings that are described in Chapter 2,
“Configuring trace logging,” on page 3. For example, trace logs grow
rapidly when you apply the ALL logging option.
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Table 4. Specific situation problems and solutions (continued)

Problem Solution

Monitoring activity requires too many
system resources.

Table 5 on page 15 describes the performance impact of specific attribute
groups. If possible, decrease your use of the attribute groups that require
greater system resources.

A formula that uses mathematical
operators appears to be incorrect. For
example, if you were monitoring Linux,
a formula that calculates when Free
Memory falls under 10 percent of Total
Memory does not work: LT
#’Linux_VM_Stats.Total_Memory’ / 10

This formula is incorrect because situation predicates support only logical
operators. Your formulas cannot have mathematical operators.
Note: The Situation Editor provides alternatives to math operators.
Regarding the example, you can select % Memory Free attribute and
avoid the need for math operators.

You see the “Unable to get attribute
name” error in the Tivoli Enterprise
Monitoring Server log after creating a
situation.

Install the agent's application support files on the Tivoli Enterprise
Monitoring Server, using the following steps:

1. Open the Manage Tivoli Enterprise Monitoring Services window.

2. Right-click the name of the monitoring server.

3. Select Advanced > Add TEMS Application Support in the pop-up
menu. Add application support, if any, for any agent that is missing
from the list. See in IBM Tivoli Monitoring Installation and Setup
Guide for more information on adding application support.

Security Audit journal based situations
don't trigger.

QAUTOMON user needs to have sufficient authority on the journal
QSYS/QAUDJRN and the current associated journal receiver for
QAUDJRN. Provide *ALL authority for QAUTOMON user on QAUDJRN
and the receivers associated with it. Set the system values QAUDLVL &
QAUDCTL with appropriate value for the type of audit data to be
journaled. DSPSECAUD/CHGSECAUD can be used to verify the current
security auditing values.

Make sure that journal entries with correct type are journaled to the
QAUDJRN journal.

Historical data collection not working
on the attributes based on
OS400_Securiy_Jrn_* and short term
history files are not created in
/QIBM/USERDATA/IBM/ITM/HIST
directory. Currently, Historical Data
collection is only working for few of the
OS400_Security_Jrn based journal entry
types.

QAUTOMON user needs to have sufficient authority on the journal
QSYS/QAUDJRN and the current associated journal receiver for
QAUDJRN. Provide *ALL authority for QAUTOMON user on QAUDJRN
and the receivers associated with it. Set the system values QAUDLVL &
QAUDCTL with appropriate value for the type of audit data to be
journaled. DSPSECAUD/CHGSECAUD can be used to verify the current
security auditing values.

Make sure that journal entries with correct type are journaled to the
QAUDJRN journal.

Accounting Journal based situations
don't trigger.

QAUTOMON user needs to have sufficient authority on the journal
QSYS/QACGJRN and the current associated journal receiver for
QACGJRN. Provide *ALL authority for QAUTOMON user on QACGJRN
and the receivers associated with it. The system value QACGLVL need to
have *JOB for account journaling to work correctly.

Events received at the Tivoli Enterprise
Console server from IBM Tivoli
Monitoring do not have values for all
event attributes (slots) even though the
values are visible in workspace views.

The problem is due to a limitation in the IBM Tivoli Monitoring interface
code that generates Tivoli Enterprise Console events from situations. The
situation results are provided in a chain of buffers of 3000 bytes each. The
interface code currently extracts event information from only the first
buffer. When situations or agent table data expands into a second buffer,
this additional data is not examined, and it is not included in events sent
to the Tivoli Enterprise Console server.
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Table 4. Specific situation problems and solutions (continued)

Problem Solution

Situations based on APPN topology
attributes don't trigger quickly.

The configuration variable KA4_COMM_SIT_INTERVAL determines the
interval for APPN related situations with a default value of 3600 seconds.
This can be set in the file QAUTOTMP/KMSPARM member KBBENV.
Setting a smaller value for this variable enables triggering of the APPN
related situations quickly as required.

The OS400_SNADS_Job_Missing
situation, which looks for missing
QROUTER jobs, runs continuously.

Set any values to reduce the jobs that are retrieved. Here are the names of
the filtering parameters that can be used to reduce the amount of
monitored jobs:

v KA4_LJOB_NAME

v KA4_LJOB_USER

v KA4_LJOB_NBR

v KA4_LJOB_TYPE

v KA4_LJOB_STS

Performance impact of each attribute group
Table 5 lists the impact on performance (high, medium, or low) of each attribute group. The
multiple-instance attributes have been classified at the lowest level. That is, the performance overhead
will increase if you do not specify compare values for one or more key values.

When you want to prevent impact on performance by any of the attribute groups listed in Table 5 you
must avoid referencing that attribute group, as suggested in this list:
v Disable the attribute group.
v Never select workspaces that reference the attribute group.
v Disable situations that reference the attribute group by using the "Undistributed situations" option in

the Situation Editor.
v Disable historical reporting that references the attribute group.
v Avoid using the "Auto Refresh" refresh feature in a Workspace because this option causes a refresh of

data for all attribute groups.

See the IBM Tivoli Monitoring User's Guide for additional information on controlling attribute group usage.

Table 5. Performance Impact by attribute group

Attribute group High Medium Low

Acct_Jrn U

Alert U

APPN_Topology U

Auxiliary Storage Pool U

Comm_Async U

Comm_Bisync U

Comm_Ethernet U

Comm_SDLC U

Comm_Token_Ring U

Comm_X25 U

Controller U

Data Queue U

Device U
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Table 5. Performance Impact by attribute group (continued)

Attribute group High Medium Low

Disk_Unit U

Database_Member U

Distribution Queue U

History Log U

i5 Disk U

I/O_Processor U

Integrated File System Object U

IOA Cache Battery U

Job U

Job Log U

Job_Queue U

Licensed Program Products U

Line U

Management Central U

Messages U

Miscellaneous U

Net Server U

Network U

Network Interface U

Network Server U

Object U

Output Queue U

PTFs U

Security_Jrn U

Security Jrn AuditJrn U

Security Jrn AuthFail U

Security Jrn ChgAuth U

Security Jrn ChgOwner U

Security Jrn ChgUserProf U

Security Jrn JobDesc U

Security Jrn Network U

Security Jrn Password U

Security Jrn ProfSwap U

Security Jrn ProgAdopt U

Security Jrn RestoreJob U

Security Jrn RestoreProg U

Security Jrn SYSVAL U

Spool_File U

Storage_Pool U

Subsystem U

16 IBM Tivoli Monitoring: IBM i OS Agent Troubleshooting Guide



Table 5. Performance Impact by attribute group (continued)

Attribute group High Medium Low

System Statistics U

System_Status U

System_Values U

System Values Acct U

System Values Device U

System Values IPL U

System Values Perf U

System Values Prob U

System Values User U

TCPIP Logical Interface U

TCPIP Service U

Problems with configuration of situations
Table 6 lists problems that might occur with situations.

This section provides information for troubleshooting for agents. Be sure to consult the IBM Tivoli
Monitoring Troubleshooting Guide for more general troubleshooting information.

Table 6. Problems with configuring situations that you solve in the Situation Editor

Problem Solution

Note: To get started with the solutions in this section, perform these steps:
1. Launch the Tivoli Enterprise Portal.
2. Click Edit > Situation Editor.
3. In the tree view, choose the agent whose situation you want to modify.
4. Choose the situation in the list. The Situation Editor view is displayed.

The situation for a specific agent is
not visible in the Tivoli Enterprise
Portal.

Open the Situation Editor. Access the All managed servers view. If the situation
is absent, confirm that application support for Monitoring Agent for IBM i OS
has been added to the monitoring server. If not, add application support to the
server, as described in the IBM Tivoli Monitoring Installation and Setup Guide.

The monitoring interval is too
long.

Access the Situation Editor view for the situation that you want to modify.
Check the Sampling interval area in the Formula tab. Adjust the time interval
as needed.

The situation did not activate at
startup.

Manually recycle the situation as follows:

1. Right-click the situation and choose Stop Situation.

2. Right-click the situation and choose Start Situation.

Note: You can permanently avoid this problem by placing a check mark in the
Run at Startup option of the Situation Editor view for a specific situation.

The situation is not displayed. Click the Action tab and check whether the situation has an automated
corrective action. This action can occur directly or through a policy. The
situation might be resolving so quickly that you do not see the event or the
update in the graphical user interface.

An Alert event has not occurred
even though the predicate has been
properly specified.

Check the logs, reports, and workspaces.

A situation fires on an unexpected
managed object.

Confirm that you have distributed and started the situation on the correct
managed system.
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Table 6. Problems with configuring situations that you solve in the Situation Editor (continued)

Problem Solution

The product did not distribute the
situation to a managed system.

Click the Distribution tab and check the distribution settings for the situation.

The situation does not fire.

Incorrect predicates are present in
the formula that defines the
situation. For example, the
managed object shows a state that
normally triggers a monitoring
event, but the situation is not true
because the wrong attribute is
specified in the formula.

In the Formula tab, analyze predicates as follows:

1. Click the fx icon of the Formula area. The Show formula window is
displayed.

a. Confirm the following details in the Formula area:
v The attributes that you intend to monitor are specified in the formula.
v The situations that you intend to monitor are specified in the formula.
v The logical operators in the formula match your monitoring goal.
v The numerical values in the formula match your monitoring goal.

b. (Optional) Click the Show detailed formula check box to see the original
names of attributes in the application or operating system that you are
monitoring.

c. Click OK to dismiss the Show formula window.

2. (Optional) In the Formula area of the Formula tab, temporarily assign
numerical values that will immediately trigger a monitoring event. The
triggering of the event confirms that other predicates in the formula are
valid.
Note: After you complete this test, you must restore the numerical values
to valid levels so that you do not generate excessive monitoring data based
on your temporary settings.

Table 7. Problems with configuration of situations that you solve in the Workspace area

Problem Solution

Situation events are not displayed
in the Events Console view of the
workspace.

Associate the situation with a workspace.
Note: The situation does not need to be displayed in the workspace. It is
sufficient that the situation be associated with any workspace.

You do not have access to a
situation.

Note: You must have administrator privileges to perform these steps.

1. Select Edit > Administer Users to access the Administer Users window.

2. In the Users area, select the user whose privileges you want to modify.

3. In the Permissions tab, Applications tab, and Navigator Views tab, select
the permissions or privileges that correspond to the user's role.

4. Click OK.

A managed system seems to be
offline.

1. Select Physical View and highlight the Enterprise Level of the navigator
tree.

2. Select View > Workspace > Managed System Status to see a list of
managed systems and their status.

3. If a system is offline, check network connectivity and status of the specific
system or application.

Table 8. Problems with configuration of situations that you solve in the Manage Tivoli Enterprise Monitoring Services
window

Problem Solution

After an attempt to restart the
agents in the Tivoli Enterprise
Portal, the agents are still not
running.

For UNIX, NetWare, or Windows, log on to the applicable system and perform
the appropriate queries.

The Tivoli Enterprise Monitoring
Server is not running.

Check the system status and check the appropriate IBM Tivoli Monitoring logs.
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Table 8. Problems with configuration of situations that you solve in the Manage Tivoli Enterprise Monitoring Services
window (continued)

Problem Solution

The managed objects you created
are firing on incorrect managed
systems.

Check the managed system distribution on both the situation and the managed
object settings sheets.

IBM i OS troubleshooting
Table 9 lists problems that might occur on the system or application that you are monitoring. See the IBM
Tivoli Monitoring Troubleshooting Guide for general troubleshooting information.

Table 9. IBM i OS problems and solutions

Problem Solution

You need to optimize performance by
choosing attribute groups that have the
least effect on performance.

See “Performance impact of each attribute group” on page 15 and
“Reducing the demand for disk space.”

You need to monitor inactivity in the
IBM i OS files.

The QAUTOTMP library contains the temporary data collected by the
IBM Tivoli Monitoring: IBM i OS Agent. The library could be empty if
IBM Tivoli Monitoring: IBM i OS Agent has not been started. Display the
library to see the current size of the temporary data.

Performance problems with the IBM
Tivoli Monitoring: IBM i OS Agent can
take the following forms:

v Long response time when working
with the IBM Tivoli Monitoring: IBM i
OS Agent on an NPT

v Long process time for activating or
deactivating situations

v Long process time for starting or
stopping activity programs

v Connection problems between the
managing system and monitoring
agents

v Connection problems between the
managing system and the Tivoli
Enterprise Portal

The subsystem QAUTOMON uses the *BASE pool. Thus, you might need
to tune some parameters related to the *BASE pool if you experience
performance problems with the IBM Tivoli Monitoring: IBM i OS Agent.

Use the Work with Active Jobs (WRKACTJOB) command and look at the
status of the jobs in subsystems QAUTOMON. If one or more of the jobs
have status ineligible (INEL), the activity level for the pool might be too
small. To avoid this, you can make one or more of these changes.

v Increase the activity level of the *BASE pool.

v Increase *BASE pool size.

v Create another pool for the QAUTOMON jobs.

v Set the IBM i OS system value QPFRADJ to 2 or 3 so that the system
automatically makes changes to improve performance.

Reducing the demand for disk space
Some multiple-instance attributes can cause a very large number of sets of data to be gathered. Specifying
predicates for additional attributes in the same attribute group might reduce the amount of data that
needs to be collected and reduce the performance impact. You must specify key attributes for each of the
following functional areas:

Accounting Journal Notification (Acct_Jrn) attributes
Specify one or more of these attributes.
v Acct_Jrn.Job_Name
v Acct_Jrn.User

File Member (DB_Member) attributes
Specify one or more of these attributes.
v DB_Member.Member
v DB_Member.File
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v DB_Member.Library

Object (Object) attributes
Specify one or more of these attributes.
v Object.Library
v Object.Name
v Object.Type

Spooled file (Spool_File) attributes
Specify one or more of these attributes.
v Spool_File.Form_Type
v Spool_File.User_Data
v Spool_File.Job_User
v Spool_File.Output_Queue_Name
v Spool_File.Output_Queue_Library

Minimizing the starting and stopping of monitoring
When a situation raises an event, monitoring for the conditions does not stop. Attribute data is collected
as long as the situation is active.

If monitoring has not been started for a situation named in an Evaluate a Situation Now activity (which
is available in policies), monitoring starts when the *EVALUATE_SITUATION activity starts. Monitoring
ends when the activity program has analyzed the conditions in the situation.

When possible, use embedded situations rather than the Evaluate a Situation Now activity. If you want
to use the Evaluate a Situation Now activity, start the situation before the *EVALUATE_SITUATION
activity begins to lessen performance impact.

20 IBM Tivoli Monitoring: IBM i OS Agent Troubleshooting Guide



Documentation library

Various publications are relevant to the use of IBM Tivoli Monitoring and to the commonly shared
components of Tivoli Management Services.

These publications are listed in the following categories:
v IBM Tivoli Monitoring library
v Related publications

Documentation is delivered in the IBM Tivoli Monitoring and OMEGAMON® XE Information Center at
http://pic.dhe.ibm.com/infocenter/tivihelp/v61r1/index.jsp and also in the Files section of the
Application Performance Management community.

For information about accessing and using the publications, select IBM Tivoli Monitoring → Using the
publications in the Contents pane of the IBM Tivoli Monitoring and OMEGAMON XE Information
Center at http://pic.dhe.ibm.com/infocenter/tivihelp/v61r1/index.jsp.

To find a list of new and changed publications, click the New in this release topic on the IBM Tivoli
Monitoring welcome page. To find publications from the previous version of a product, click Previous
versions under the name of the product in the Contents pane.

IBM Tivoli Monitoring library
The IBM Tivoli Monitoring library provides information about the commonly shared components of
Tivoli Management Services.
v Quick Start Guide

Introduces the components of IBM Tivoli Monitoring.
v Installation and Setup Guide, SC22-5445

Provides instructions for installing and configuring IBM Tivoli Monitoring components on Windows,
Linux, and UNIX systems.

v High Availability Guide for Distributed Systems, SC22-5455
Gives instructions for several methods of ensuring the availability of the IBM Tivoli Monitoring
components.

v Program Directory for IBM Tivoli Management Services on z/OS, GI11-4105
Gives instructions for the SMP/E installation of the Tivoli Management Services components on z/OS.

v Administrator's Guide, SC22-5446
Describes the support tasks and functions required for the Tivoli Enterprise Portal Server and clients,
including Tivoli Enterprise Portal user administration.

v Command Reference available on Service Management Connect
Provides detailed syntax and parameter information, as well as examples, for the commands you can
use in IBM Tivoli Monitoring.

v Messages available on Service Management Connect
Lists and explains messages generated by all IBM Tivoli Monitoring components and by z/OS-based
Tivoli Management Services components (such as Tivoli Enterprise Monitoring Server on z/OS and
TMS:Engine).

v Troubleshooting Guide available on Service Management Connect
Provides information to help you troubleshoot problems with the software.

v Tivoli Enterprise Portal User's Guide available on Service Management Connect
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Complements the Tivoli Enterprise Portal online help. The guide provides hands-on lessons and
detailed instructions for all Tivoli Enterprise Portal features.

v Tivoli Enterprise Portal online help
Provides context-sensitive reference information about all features and customization options of the
Tivoli Enterprise Portal. Also gives instructions for using and administering the Tivoli Enterprise
Portal.

Documentation for the base agents
If you purchased IBM Tivoli Monitoring as a product, you received a set of base monitoring agents as
part of the product. If you purchased a monitoring agent product (for example, an OMEGAMON XE
product) that includes the commonly shared components of Tivoli Management Services, you did not
receive the base agents.

The following publications provide information about using the base agents.
v Agentless operating system monitors

– Agentless Monitoring for Windows Operating Systems User's Guide, SC23-9765
– Agentless Monitoring for AIX Operating Systems User's Guide, SC23-9761
– Agentless Monitoring for HP-UX Operating Systems User's Guide, SC23-9763
– Agentless Monitoring for Solaris Operating Systems User's Guide, SC23-9764
– Agentless Monitoring for Linux Operating Systems User's Guide, SC23-9762

v OS agent documentation is delivered in the following locations:

Agent Installation and Configuration Guide
Available in the Information Center:
– IBM i OS Agent Installation and Configuration Guide, SC27-5653
– Linux OS Agent Installation and Configuration Guide, SC27-5652
– UNIX OS Agent Installation and Configuration Guide, SC27-5651
– Windows OS Agent Installation and Configuration Guide, SC27-5650

Agent Reference
Available on Service Management Connect

Agent Troubleshooting Guide
Available on Service Management Connect

Infrastructure Management Dashboards for Servers Reference
Available on Service Management Connect

v Warehouse agent documentation is delivered in the following locations:

Agent Installation and Configuration Guide
Available in the Information Center:
– Warehouse Proxy Agent Installation and Configuration Guide, SC27-5655
– Warehouse Summarization and Pruning Agent Installation and Configuration Guide, SC27-5654

Agent Reference
Available on Service Management Connect

Agent Troubleshooting Guide
Available on Service Management Connect

v System P agents
– AIX Premium Agent User's Guide, SA23-2237
– CEC Base Agent User's Guide, SC23-5239
– HMC Base Agent User's Guide, SA23-2239
– VIOS Premium Agent User's Guide, SA23-2238
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v Other base agents
– Agent Builder User's Guide, SC32-1921
– Performance Analyzer User’s Guide, SC27-4004
– Systems Director base Agent User’s Guide, SC27-2872
– Tivoli Log File Agent User’s Guide, SC14-7484
– Tivoli zEnterprise Monitoring Agent User’s Guide, SC14-7359 and the Tivoli zEnterprise Monitoring Agent

Installation and Configuration Guide, SC14-7358

Related publications
For information about related products and publications select OMEGAMON XE shared publications or
other entries in the Contents pane of the IBM Tivoli Monitoring and OMEGAMON XE Information
Center.

You can access the IBM Tivoli Monitoring and OMEGAMON XE Information Center at
http://pic.dhe.ibm.com/infocenter/tivihelp/v61r1/index.jsp .

You can also access other information centers at IBM Tivoli Documentation Central (https://
www.ibm.com/developerworks/community/wikis/home?lang=en#!/wiki/Tivoli%20Documentation
%20Central).

Tivoli Monitoring community on Service Management Connect
Connect, learn, and share with Service Management professionals: product support technical experts who
provide their perspectives and expertise.

For information about Tivoli products, see the Application Performance Management community on SMC
at IBM Service Management Connect > Application Performance Management (http://www.ibm.com/
developerworks/servicemanagement/apm).

For introductory information, see IBM Service Management Connect (http://www.ibm.com/
developerworks/servicemanagement).

Use Service Management Connect in the following ways:
v Become involved with transparent development, an ongoing, open engagement between other users

and IBM developers of Tivoli products. You can access early designs, sprint demonstrations, product
roadmaps, and prerelease code.

v Connect one-on-one with the experts to collaborate and network about Tivoli and the (enter your
community name here) community.

v Read blogs to benefit from the expertise and experience of others.
v Use wikis and forums to collaborate with the broader user community.

Other sources of documentation
You can obtain additional technical documentation about monitoring products from other sources.
v Tivoli wikis

IBM Service Management Connect > Application Performance Management (http://www.ibm.com/
developerworks/servicemanagement/apm) includes a list of relevant Tivoli wikis that offer best
practices and scenarios for using Tivoli products, white papers contributed by IBM employees, and
content created by customers and business partners.
Two of these wikis are of particular relevance to IBM Tivoli Monitoring:
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– The IBM Tivoli Monitoring Wiki (https://www.ibm.com/developerworks/community/wikis/
home?lang=en#!/wiki/Tivoli%20Monitoring) provides information about IBM Tivoli Monitoring and
related distributed products, including IBM Tivoli Composite Application Management products.

– The Tivoli System z® Monitoring and Application Management Wiki provides information about the
OMEGAMON XE products, NetView® for z/OS, Tivoli Monitoring Agent for z/TPF, and other
System z monitoring and application management products.

v IBM Integrated Service Management Library
http://www.ibm.com/software/brandcatalog/ismlibrary/
IBM Integrated Service Management Library is an online catalog that contains integration
documentation and other downloadable product extensions.

v Redbooks®

http://www.redbooks.ibm.com/
IBM Redbooks and Redpapers include information about products from platform and solution
perspectives.

v Technotes
Technotes provide the latest information about known product limitations and workarounds. You can
find Technotes through the IBM Software Support Web site at http://www.ibm.com/software/
support/.
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Support information

If you have a problem with your IBM software, you want to resolve it quickly. IBM provides ways for
you to obtain the support you need.

Online
The following sites contain troubleshooting information:
v Go to the IBM Support Portal (http://www.ibm.com/support/entry/portal/software) and

follow the instructions.
v Go to IBM Service Management Connect > Application Performance Management

(http://www.ibm.com/developerworks/servicemanagement/apm) and select the appropriate
wiki.

IBM Support Assistant
The IBM Support Assistant (ISA) is a free local software serviceability workbench that helps you
resolve questions and problems with IBM software products. The ISA provides quick access to
support-related information and serviceability tools for problem determination. To install the ISA
software, go to IBM Support Assistant (http://www-01.ibm.com/software/support/isa).

Troubleshooting Guide
For more information about resolving problems, see the product's Troubleshooting Guide.

Using IBM Support Assistant
The IBM Support Assistant is a free, stand-alone application that you can install on any workstation. You
can then enhance the application by installing product-specific plug-in modules for the IBM products you
use.

The IBM Support Assistant saves you the time it takes to search the product, support, and educational
resources. The IBM Support Assistant helps you gather support information when you need to open a
problem management record (PMR), which you can then use to track the problem.

The product-specific plug-in modules provide you with the following resources:
v Support links
v Education links
v Ability to submit problem management reports

For more information, and to download the IBM Support Assistant, see http://www.ibm.com/software/
support/isa. After you download and install the IBM Support Assistant, follow these steps to install the
plug-in for your Tivoli product:
1. Start the IBM Support Assistant application.
2. Select Updater on the Welcome page.
3. Select New Properties and Tools or select the New Plug-ins tab (depending on the version of IBM

Support Assistant installed).
4. Under Tivoli, select your product, and then click Install. Be sure to read the license and description.

If your product is not included on the list under Tivoli, no plug-in is available yet for the product.
5. Read the license and description, and click I agree.
6. Restart the IBM Support Assistant.
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Obtaining fixes
A product fix might be available to resolve your problem. To determine which fixes are available for your
Tivoli software product, follow these steps:
1. Go to the IBM Software Support website at http://www.ibm.com/software/support.
2. Under Select a brand and/or product, select Tivoli.

If you click Go, the Search within all of Tivoli support section is displayed. If you don't click Go,
you see the Select a product section.

3. Select your product and click Go.
4. Under Download, click the name of a fix to read its description and, optionally, to download it.

If there is no Download heading for your product, supply a search term, error code, or APAR number
in the field provided under Search Support (this product), and click Search.

For more information about the types of fixes that are available, see the IBM Software Support Handbook at
http://www14.software.ibm.com/webapp/set2/sas/f/handbook/home.html.

Receiving weekly support updates
To receive weekly e-mail notifications about fixes and other software support news, follow these steps:
1. Go to the IBM Software Support website at http://www.ibm.com/software/support.
2. Click My support in the far upper-right corner of the page under Personalized support.
3. If you have already registered for My support, sign in and skip to the next step. If you have not

registered, click register now. Complete the registration form using your e-mail address as your IBM
ID and click Submit.

4. The Edit profile tab is displayed.
5. In the first list under Products, select Software. In the second list, select a product category (for

example, Systems and Asset Management). In the third list, select a product sub-category (for
example, Application Performance & Availability or Systems Performance). A list of applicable
products is displayed.

6. Select the products for which you want to receive updates.
7. Click Add products.
8. After selecting all products that are of interest to you, click Subscribe to email on the Edit profile

tab.
9. In the Documents list, select Software.

10. Select Please send these documents by weekly email.
11. Update your e-mail address as needed.
12. Select the types of documents you want to receive.
13. Click Update.

If you experience problems with the My support feature, you can obtain help in one of the following
ways:

Online
Send an e-mail message to erchelp@ca.ibm.com, describing your problem.

By phone
Call 1-800-IBM-4You (1-800-426-4968).

Contacting IBM Software Support
IBM Software Support provides assistance with product defects. The easiest way to obtain that assistance
is to open a PMR or ETR directly from the IBM Support Assistant.
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Before contacting IBM Software Support, your company must have an active IBM software maintenance
contract, and you must be authorized to submit problems to IBM. The type of software maintenance
contract that you need depends on the type of product you have:
v For IBM distributed software products (including, but not limited to, Tivoli, Lotus®, and Rational®

products, as well as DB2® and WebSphere® products that run on Windows or UNIX operating
systems), enroll in Passport Advantage® in one of the following ways:

Online
Go to the Passport Advantage website at http://www-306.ibm.com/software/howtobuy/
passportadvantage/pao_customers.htm .

By telephone
For the telephone number to call in your country, go to the IBM Software Support website at
http://techsupport.services.ibm.com/guides/contacts.html and click the name of your
geographic region.

v For customers with Subscription and Support (S & S) contracts, go to the Software Service Request
website at https://techsupport.services.ibm.com/ssr/login.

v For customers with Linux, iSeries®, pSeries, zSeries, and other support agreements, go to the IBM
Support Line website at http://www.ibm.com/services/us/index.wss/so/its/a1000030/dt006.

v For IBM eServer™ software products (including, but not limited to, DB2 and WebSphere products that
run in zSeries, pSeries, and iSeries environments), you can purchase a software maintenance agreement
by working directly with an IBM sales representative or an IBM Business Partner. For more information
about support for eServer software products, go to the IBM Technical Support Advantage website at
http://www.ibm.com/servers/eserver/techsupport.html.

If you are not sure what type of software maintenance contract you need, call 1-800-IBMSERV
(1-800-426-7378) in the United States. From other countries, go to the contacts page of the IBM Software
Support Handbook on the web at http://www14.software.ibm.com/webapp/set2/sas/f/handbook/
home.html and click the name of your geographic region for telephone numbers of people who provide
support for your location.
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Notices

This information was developed for products and services offered in the U.S.A. IBM may not offer the
products, services, or features discussed in this document in other countries. Consult your local IBM
representative for information on the products and services currently available in your area. Any
reference to an IBM product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product, program, or service that
does not infringe any IBM intellectual property right may be used instead. However, it is the user's
responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this
document. The furnishing of this document does not give you any license to these patents. You can send
license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785 U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property
Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan, Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other country where such
provisions are inconsistent with local law :

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR
FITNESS FOR A PARTICULAR PURPOSE.

Some states do not allow disclaimer of express or implied warranties in certain transactions, therefore,
this statement might not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically
made to the information herein; these changes will be incorporated in new editions of the publication.
IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in
any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of
the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without
incurring any obligation to you.
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Licensees of this program who wish to have information about it for the purpose of enabling: (i) the
exchange of information between independently created programs and other programs (including this
one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Corporation
2Z4A/101
11400 Burnet Road
Austin, TX 78758 U.S.A.

Such information may be available, subject to appropriate terms and conditions, including in some cases
payment of a fee.

The licensed program described in this document and all licensed material available for it are provided
by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or
any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the
results obtained in other operating environments may vary significantly. Some measurements may have
been made on development-level systems and there is no guarantee that these measurements will be the
same on generally available systems. Furthermore, some measurement may have been estimated through
extrapolation. Actual results may vary. Users of this document should verify the applicable data for their
specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their
published announcements or other publicly available sources. IBM has not tested those products and
cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM
products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of
those products.

All statements regarding IBM's future direction or intent are subject to change or withdrawal without
notice, and represent goals and objectives only.

All IBM prices shown are IBM's suggested retail prices, are current and are subject to change without
notice. Dealer prices may vary.

This information is for planning purposes only. The information herein is subject to change before the
products described become available.

This information contains examples of data and reports used in daily business operations. To illustrate
them as completely as possible, the examples include the names of individuals, companies, brands, and
products. All of these names are fictitious and any similarity to the names and addresses used by an
actual business enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrate programming
techniques on various operating platforms. You may copy, modify, and distribute these sample programs
in any form without payment to IBM, for the purposes of developing, using, marketing or distributing
application programs conforming to the application programming interface for the operating platform for
which the sample programs are written. These examples have not been thoroughly tested under all
conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these
programs. You may copy, modify, and distribute these sample programs in any form without payment to
IBM for the purposes of developing, using, marketing, or distributing application programs conforming
to IBM's application programming interfaces.
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Each copy or any portion of these sample programs or any derivative work, must include a copyright
notice as follows: © (your company name) (year). Portions of this code are derived from IBM Corp.
Sample Programs. © Copyright IBM Corp. 2013. All rights reserved.

If you are viewing this information in softcopy form, the photographs and color illustrations might not be
displayed.
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